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March 3, 2015 

Tonight’s Agenda 

Questions? 

Using the Edit, View, and Tools Menu 

Fixing Relationship Issues 

Recording Ancestor Sources 

Using Maps to Search for Ancestor Locations 

Finding and Adding GPS Coordinates 

Creating Ancestor Migration Maps 

 

References to numbered bracket boxes, ie, [1], in each paragraph are shown in each figure 

located above or below the numbered paragraphs. 

Using the Edit, View, and Tools Menu 

 

Edit Menu 

 

As in past FTM versions and all Windows based applications, the Edit menu is similar to other 

programs. The standard features of the edit menu include undo, redo, cut, copy, paste, delete, & 

select all. Insert Symbol allows users to add different accents for different letters of varying 

languages as used in Person or Research Notes for each ancestor. There are shortcut keys for 

users if lots of repetition is used for any of these special tools. The shortcut keys are listed in the 

different menu items. 

 

 Edit Person allows users to modify Facts, Notes, and Media categories of any individual, and 

Edit Relationships does the same for marriages or companions. The Find Duplicate People 

feature, allows users to locate the same or similar names, especially if merging two family files. 

This is helpful to eliminate the same people from another family file. Find Individual does 

exactly that, providing you have the person’s name in your family file. A text box appears with 

the name that you specified and shows all locations for that particular name in your family file. 

Alternately, users can go to the Index of Individuals to locate the same person. Find and 

Replace allows users to search for a particular word or phrase and replace it with your preferred 

word or phrase in the case of misspelled names or words. 

 

Manage Facts allows users to add, delete, or modify any fact in the available facts list. Manage 

Sources allows users to add, edit, replace, and delete source citations located in the Master 

Source file. Manage Repositories allows users to add, edit, replace, or delete research 
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repositories such as county courthouses, libraries, etc. And Manage Historical Events allows 

users to add, modify, or delete historical events that you may want to include in your Notes or 

Smart Stories.™ 

 

View Menu 

 

The View Menu allows users to move forward to the next screen or back to the previous screen. 

Also the seven workspace tabs can be accessed here, but faster access is utilized by using the 

tabs at the top of FTM screen. There are shortcut keys for faster access for the workspace tabs as 

listed in the View menu item. 

  

Tools Menu 

 

A. Date Calculator 

The Tools menu allows users to have access to several useful tools that were part of previous 

versions of FTM. The Date Calculator can give any date if the birth date, death date, or other 

special date is known as shown in Figure 1 below. 

 

 
Figure 1. Date Calculator  

 

As shown above, select the [1] preferred item required. If the [2] birth date is already recorded 

for any ancestor, users can find the [3] age for any event time by completing the [4] special 

event, such as a marriage date. Other dates can be found by providing two of the three required 

fields of information. 

 

B. Relationship Calculator 

The Relationship Calculator determines the relationship between any individual in your family 

file as shown in Figure 2 on the next page. 
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Step [1] shows the first selected person in the calculator. Individuals can be selected by choosing 

the index card icon to the right of the person’s name. The Index of Individuals list appears and 

the preferred ancestor’s name is selected from that list. Or the home person can be selected by 

selecting the house icon. The Home icon allows users to select the home ancestor. 

 

Step [2] allows users to select another family name by selecting either two of the same two icons 

as mentioned above. Step [3] shows the relationship between the two people selected in steps [1] 

and [2]. And finally, step [4] allows users to View and print the results. 

 

 
Figure 2.  Relationship Calculator 

 

C. Soundex Calculator 

The Soundex Calculator is a helpful tool for determining the Soundex value for any surname as 

shown in Figure 3 below. Soundex is used with many older documents created by the U.S 

Government. Inserting a surname in the Name field will yield the Soundex value.  

 

Soundex is a method of coding names with unique numbers based on the way the names sound—not on 

their spelling. Soundex was used for several U.S. census reports and passenger lists to help users find 

surnames based on similar sounds. Obviously, the census or passenger list record takers misspelled many 

names due to the sounds of the ancestor names taken at the time. Soundex is a great method to locate 

many of those misspelled names of ancestors. Unfortunately it’s not used today by our government, but 

several genealogy database companies still use this method. 
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Figure 3. Soundex Calculator 

D. Fixing Relationship Issues 

 

Let’s face it! No matter how organized you are, mistakes will happen when entering your 

ancestors into the family tree. Sometimes the wrong child is linked to the wrong family or the 

wrong parents. Or the same child is entered twice with two different names and dates. The 

mistakes are easily fixed as FTM will make you aware of most mistakes due to the mistake alerts 

in the program. But occasionally, you may have either merged new members or children get 

separated from their parents for no apparent reason. 

 

The most common mistakes are listed here. For instance, merging duplicate individuals happens 

often, but don’t delete one child as you may lose important Fact information for the same child. 

Instead merge the two children together by selecting the People Workspace, Family tab. Select 

the Person menu item at top, and ‘Merge Two Specific Individuals.’ Select the duplicate 

person from the Index of Individuals window that appears, and select ‘OK’ to start the merging 

process. Then select the preferred or alternate Facts for the same individual. Users can Discard 

the Fact if not true, then select ‘OK’ to finalize the merging process. 

 

Removing individuals from a tree that aren’t related is easy too. From the People Workspace and 

Family tab at the top, select the individual from the Index of Individuals from the icon at top. 

Select Person from the menu items at top and Delete Person, Confirm as Yes. However, be 

aware that all dates, locations, and Facts will disappear for that person totally.  

 

 
Figure 4. Detaching Children 
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If you just need to just detach a person from the wrong parents, users need to select the child in 

the same Family tab from the People Workspace button. From the same Person menu items at 

top, select Attach/Detach Person, then select Detach Selected Person and OK to complete the 

process as shown in Figure 4 on the previous page. 

 

E. Resolve All Place Names 

Occasionally, locations errors will happen. As shown in Figure 5 below, users can Resolve All 

Place Names by selecting this menu item. Users can correct location names that are not found in 

the Family Tree Maker database. You can correct the name so it is spelled correctly and in a 

consistent format throughout your tree file or have Family Tree Maker accept the place name as 

you entered it. Users have several options to modify the information or leave as is. 

 

Figure 5. Resolve All Place Names Results List 

[1] Users can select the unrecognized name as listed in the family file or select the suggested 

replacement name. Be sure you want to do this before accepting the replacement name, which 

may not be the correct place name. 

 

[2] Users have three options to select the preferred place name from step 1. Users can move the 

replacement name to the Description field of the fact for that ancestor. Users can also remove 

either the unrecognized name or the suggested name from the list by selecting the Ignore option. 

Or if the replacement name isn’t satisfactory, then users can select the Other icon to select from 
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a list of different possible place names for closer matches or edit the existing name. Users can 

view [3] the amount of conflicts to be resolved n the family file. 

 

F. Convert Names 

Users can convert names to different text styles as shown in Figure 6 below. The surname can be 

in capital letters or leave as standard text format. 

 

 
Figure 6. Convert Names 

G. Compact Files 

Compacting Files may be required as users keep adding to the family file. The file size will 

increase with more names being added. I recommend users compact their family files every six 

months, if more than several hundred names are added every six months as shown below in 

figure 7.  

 
Figure 7. Compacting Files 

 

The compact process will make FTM software operate faster and smoother in operation. This is 

similar to defragmenting your hard drive after a long use of time. Compacting the file may take 

several minutes, depending on the size of your tree file. I recommend users backup the main family file 

before compacting it as a safety precaution. Simply check the backup box for this option. 

 

H. User Information 

Users have the option to complete their personal contact information for insertion into the many 

different reports. Users may want to use it so relatives will know how to contact the author of the 

reports for additional copies or for corrections.  
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I. Options 

Users can change system settings for the FTM software. Besides the standard settings for 

changing file directories for new trees, fastfields, spelling, FTM has options on dates and names, 

and multiple warning alerts as shown below in figure 8. 

 

 
Figure 8. Options Settings 

 

Recording Ancestor Sources 

Tip: This is a very important step for all genealogists! Documenting sources are important for 

several reasons. First, sources validate your genealogy and family history research. Second, if 

you share your genealogy with other family members, they will know that your research is 

accurate, and last, sources can help organize your research work. 

 

FTM’s software dedicates a section just for sources. This is a nice reminder for all genealogists 

to cite those important documents. FTM creates both Master Sources and source citations. 

Master sources are facts about an ancestor that can be repeated for many source citations used for 

different events and different individuals.  Source citations are the individual details for a fact of 

any ancestor, ie, BMD info recorded in a record book by any government entity. 
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A. Add New Source Citation 

There are several methods to start a Master Source. Selecting the People workspace, then select 

either family or person tabs, then select the source icon in the editing panel on the far right side 

of the screen. The editing panel may need to be expanded if it doesn’t show on the screen. Then 

select Add New Source Citation as shown below in Figure 9. 

 

 [1] add the name of the document using a specific ancestor name as similar documents will be 

used in Master Sources that can be duplicated for other family members as required. 

 

[2] Users can add the citation detail about the location of the document, ie, county courthouse, 

family member’s home, etc.  

 

[3] Citation text would include document summary details. No need to copy the entire document 

text, but briefly summarize. [4] Users can copy the citation information into [5] Reference Notes, 

which can be made available in family group sheets and many genealogy reports. 

 

[6] Users can import the scanned document or online database image directly into the Media 

section of the source citation by selecting that tab and follow the instruction outlined in the Help 

button. The scanned document or image must be imported into the master media file so that an 

internal link can be associated with the source citation. Another method is to use the Web Merge 

Wizard to import the image directly from Ancestry. I’ll discuss this method in more detail in our 

next class. 

 
Figure 9. Add Source Citation Tool 

 

[7] Users can add more detailed information in the Notes as required.  
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[8] Users can add more source citations or edit the existing ones as necessary.  

[9] Users can copy the contents of the text for later use into another citation. 

[10] Be sure to add the repository location, which can be used instead of the citation detail if 

there are a lot of documents that came from the same source, such as a family member, county 

courthouse, online database, or library. To add a new repository, select Edit menu, Manage 

Repositories, and select New. Complete the new repository information and select OK. Once the 

Master Source has been established, another family member can use the same source citation if it 

applies. 

 

Tip: The handy source wizard tool gives users the ability to enter the correct source information 

based upon Elizabeth Shown Mills 1997 book, Evidence! Citation and Analysis for the Family 

Historian. I suggest following the wizard format, so you can get into the habit of adding source 

information for each new Fact or document. 

 

B. Finding Existing Source Citations 

If you have created a marriage license or certificate source, you don’t have to duplicate the 

source for the spouse or duplicate other documents when several people are connected to the 

same source. Select ‘Find Source Citation’ as shown below in figure 10. 

 
Figure 10. Find Source Citation 

 

[1] Select one of four options from pull down menu to locate the existing source(s) to connect to 

your ancestor. [2] Select preferred source citation in the second column, then [3] link citation to 

ancestor. 

3 

2 1 
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C. Source Citation Rating System 

Another nice feature of the Master Sources is their rating system, which allows users to give a 

rating of the source, list it as original or derivative, and type of evidence as shown in Figure 11 

below. Do use it to check your own ratings! 

 

You can [1] manually rate the document quality or [2] let FTM rate it automatically. To open the 

source rating system, select the Sources workspace at the top, select the preferred source from 

the list on the left side, then select the link at the bottom center, then select the source for that 

person’s name, then finally select the star icon above the name(s). A Rating box appears.  

 

[1] Review each of the categories and rate them accordingly. The highest rating is 5 stars, which 

indicates users have the original clear document and is considered primary or direct evidence. 

 

[3] Users can add the justification by indicating more information about the document as 

necessary. It’s okay to have lower star ratings, but 3 or 4 star ratings are preferable.  

 
Figure 11. Source Citation Rating System 

 

Important Note: It’s recommended that all genealogists list sources to verify your work and 

always check a second source to verify indirect or any direct document source.  

Using Maps to Search for Ancestor Locations 

 

FTM partnered with Microsoft Virtual Earth© maps to illustrate thousands of maps all over the 

world. Satellite imagery is also shown for selected regions of the world including the United 

States, United Kingdom, Canada, and Australia. More satellite imagery will be included over 

time without the need for special downloads to your computer. The Bird’s Eye view shows 

close-up details of your ancestor’s home in larger towns and cities. The satellite images are not 

live, but taken several months ago. The map feature uses the Internet to generate the latest map 

databases. Because of this feature, it takes several seconds to download the selected map to your 
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FTM software. A map migration feature has been included for users to print a map with 

migration paths of their ancestors. 

A. Viewing Ancestor Maps 

As shown in Figure 12 below, the Places workspaces shows different maps in second or third 

dimensional views, road map view, or satellite or bird’s eye views. [1] Users can select which 

map is preferred from the list of place locations listed in the left collapsible panel. The map 

feature will access the Internet and display the second dimensional road map view to validate 

your ancestor’s location. Users can navigate the road map by selecting [2] navigate wheel or drag 

or move the map any direction using the mouse.  

[3] Users can zoom in or out on any selected map by selecting the plus or minus signs. 

 

Figure 12. Places Map 

 [4] Users can see third dimensional, satellite or bird’s eye view. The Bird’s Eye view will not be 

available for all areas in the United States or the world, even though the satellite view will show 

most of these areas. 

[5] The Places lists the different family members who live at the selected map location, based 

upon your data input. If you didn’t list the location for some relatives, no map will be shown for 

them. To add more map locations requires users to add more ancestor locations to the main 

People workspace. 

 [6] Users can type in ‘cemetery’ in the location field to locate the closest cemetery or other 

preferred place in that area. 
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B.   Finding and Adding GPS Coordinates 

This feature includes GPS tracking on the Microsoft virtual maps. Users can easily find and add 

GPS coordinates for any location in the Places workspace right panel as shown below in Figure 

13 below for any location. The virtual maps now include the coordinates in decimal degree 

format at the bottom right of each map by adding the new 3D map software program. By 

selecting the [1] red push pin shown below in the right panel, coordinates are automatically 

added to the location field. Or enter coordinates manually using a GPS tracking device.  

New feature: Changes to the marker location to correct the coordinates if needed can be achieved 

by using the [2] pull down menu as shown below. Users simply select Set location from map or 

parent and click on the correct map location field with your mouse pointer and coordinates will 

automatically correct itself. If not correct, use reset in the pull down menu.  

.  

Figure 13. Adding GPS Coordinates 

Users can also look at the different GPS coordinate formats for any location as shown below in 

Figure 14. Users can use a portable GPS locator, auto GPS locator, or a smartphone with the 

correct GPS app to find the location or track the GPS coordinates of a grave or other location of 

your ancestor using the portable GPS tracking devices. 

 

Figure 14. GPS Location Calculator 

1 
2 
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Maps of ancestors likely changed over time, especially prior to 1900. Users can Google older 

maps on the Internet. Some older maps are free, but users can purchase higher definition maps 

for a family history report or family history book. One recommended vendor is Generation Maps 

that sells many varieties of maps. 

C.   View and Print Migration Maps of Ancestors 

Are you interested in knowing where your ancestor started his journey and finally landed before 

his death? This is a nice feature that has the ability to track each ancestor as shown in Figure 15 

below, providing you listed the different location Facts with dates about that ancestor, ie, BMD 

and other details of his movements. 

Users can show a detailed ancestor migration map of the different locations either on a 

worldwide map or just the United States. Select the [1] Places workspace, then select the [2] 

Person list by category in the left panel, then [3] select the family member in the list. The map 

will download with migration lines between each location you have listed in your Facts list. [4] 

Users can verify the migration route by reviewing all the different locations in the ancestor’s 

places listing in the right panel. 

 
Figure 15. Ancestor Migration Map 

 [5] Users can print the map or include into a genealogy report or book. Users can only print 

second or third dimensional and satellite views of any map, but not the bird’s eye view. 

Note: Users can select the  ‘Alt’ and Print Screen keys to save the migration map into the 

Windows computer memory, then save into a blank report or Word document for future use. 
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Homework Assignment 

Try these features at home. Create new sources for new images or new facts added for each of 

your ancestors. Try the source rating tool to see if your sources are 3 or 4 star rating. View and 

create several migration maps of your ancestors. Add or check several GPS coordinates to your 

ancestor’s favorite locations. Review and correct several conflicts using Resolve All Place 

Names. And finally, try printing a migration map of one of your ancestor who traveled across 

two or more states. 

Latest Update 

There has been several new software upgrades for FTM 2015. The latest version is 22.0.0.345, 

which can be downloaded for free after registering your software. Without registering, no 

updates will be given. 

Next Meeting 

Our next FTM User Group meeting will be held on April 6 at the Harmony Public Library at 

6:30 pm. An email will be sent and the class is listed on our society website listed below. 

Handouts will be available on our website at www.lcgsco.org. You can email me at 

FTM@lcgsco.org if you have problems. Happy Trails and enjoy researching! 

http://www.lcgsco.org/
mailto:FTM@lcgsco.org

